
Creating A Squad Battles Scenario From Scratch 
 
This document will take you through the process of designing a small Squad Battles scenario from the 
ground up.  We will use the three main editors that come with the game, the Order-Of-Battle Editor, the 
Submap Editor and the Scenario Editor itself.  Once you get the hang of these three programs, with a little 
research and time, you can begin to produce your own small scenarios and greatly enhance your enjoyment 
and understanding of the Squad Battles system. 
 
The OOB Editor 
 
First off, let’s make the oob.  Open up the Order-Of-Battle Editor, click ‘Cancel’ when prompted to open an 
existing oob.  From the ‘Data’ drop down menu select ‘Add’ or simply click the ‘Add’ button on the toolbar.  
The Org/Unit Dialog box will open.  Leave the Nation set to the default Side 1, in this case, French.  
Although we can go as large as a Division for the Category size, for this small scenario, let’s select 
‘Company’ and name it ‘Company A’.  
 

 
 
 
We’ll want a leader for the company, so click on Company A and once again select/click ‘Add’.  Again the 
Org/Unit Dialog comes up and the Category defaults to the next lowest organizational level, in this case, 
Platoon.  However we are adding an individual item, so need to select ‘Unit’ from that drop down menu.  
Doing that makes the Type box active and it defaults to Leader.  A photo comes up.  You can scroll through 
pictures using the up down arrows next to pictures and toggle through available picture sets by clicking the 



Default/Alt 1/Alt 2/etc button until you find one suitable.  You can also 
set the Quality of the leader in the drop down box in the center.  Let’s 
make him a ‘B’.  Our man will also need a name, Captain Renard, for 
example.  Click OK and he will appear in the oob tree subordinate to 
Company A. Renard could use a carbine so let’s give him one.  Again, 
with Company A selected, click Add, then  Category  unit, but this 
time rather than Leader for Type, select Weapon.  The Weapon drop 
down box becomes active, scroll through to find an appropriate Carbine 
for our Captain, in this case an M1 Carbine and select OK.  The carbine 

now appears in the tree immediately after Renard. 
 
Before going further, let’s save our work.  Save the file as Scratch.oob.   
 
We will now add an HQ squad.  Again, with Company A selected, click/select Add, then Unit from 
Category, but then ‘Team’ in the Type box.  Type HQ Squad for Name, and enter 6 for Strength and C for 
quality. Click OK and they will be added to the oob tree.  They’ll need weapons and we should also assign 
them a radio.  Using the same process as giving the carbine to Renard, give this squad 6 MAS-36 rifles.  In 
the Org/Unit dialog make sure you set the Strength to 6, rather than add 6 individual rifles.  Repeat this 
process for 1 SCR-300. 
 
We are now ready to add a Platoon.  Save your work. 
 
With Company A still selected, click/select Add.  Leave the Category at 
Platoon and name it 1st Platoon and click OK.  We’ll need to add in a leader 
and squads to 1st Platoon, so now select 1st Platoon in the tree (rather than 
Company A).  Repeat the process above to add a leader also armed with a 
Carbine.  Name him Lt. Dan.  If you make any mistakes you can select Edit 
from the Data menu or click on the Edit button.   You can also delete an entry 
completely if you wish. 
 
1st Platoon will have 3 squads.  We’ll add them now. Use the same process as 
you did for the HQ Squad (Category  Unit, Type  Team).  Give the 
squad a strength of 12 and name it 1/1 Squad.  Now select 1/1 Squad  and 
either from the Data menu or the toolbar select ‘Copy’.  Select 1st Platoon from the tree and then from the 
data menu/toolbar select ‘Paste’.  Repeat.  You should now have three identical Squads.  To differentiate 
them, we can edit their name.  Select the second from the list and select Edit from the Data menu or click the 
Edit button of the tool bar. Change the name to 1/2 Squad and the third to 1/3 Squad.  They’ll need weapons 
so we’ll add them now.  With 1st Platoon selected, create an entry for 9 MAS-36 rifles.  Copy/Paste it 2 times 
so that you now have three entries.  Select one of the MAS-36 entries and then using the Up Arrow button of 
the toolbar move one MAS-36 entry just below 1/1 Squad and another just below 1 / 2 Squad.  (This will 
also leave just one entry below 1/3).  Repeat this process to add 2 MAT-49’s and 1 FM24/29 to each squad. 
 
Save your work.  Now we’ll double the size of our force by copying the 1st Platoon.  Select 1st Platoon and 
Copy from the Toolbar/Data Menu.  Now click Company A then select Paste from the Data Menu/Toolbar.  
Select this new 1st Platoon entry and rename it 2nd Platoon.  Rename Lt. Dan  Lt. Roger.  Rename the 
squads  2/1 Squad, 2/2 Squad, 2/3 Squad.  We’ll now mount this second Platoon on trucks.  Select 2nd 
Platoon and Click/Select Add.  In the Org/Unit Dialog, select Category Unit and Type Vehicle.  The 
Vehicle drop down is now active.  Select 2-1/2 Ton Truck and click OK.  Select the truck, use Copy/Paste to 
add 2 more trucks. Use the arrow button to move one truck all the way to the top of the Platoon, above Lt. 
Roger.  Move the second just above 2/2 Squad and the third above 3/2 Squad.  You don’t have to place the 
tucks there, but it will make deployment faster when we are in the Scenario Editor. 



 
We’ll give the French some support both on the ground and from the 
air.  First we’ll attach a pair of tanks to the Company A.  We could 
create their own platoon, but in this case we will add them directly to 
the Company A structure.  Select Company A, then Add.  In the 
Org/Unit Dialog, Category  Unit, Type  Vehicle.  Pick a M-8 
Greyhound, Copy/Paste to add a second.  On second thought let’s 
make that M-8 a M-5A1 Stuart.  Select the second M-8 and 
click/select Edit.  Simply change the M-8 in the Vehicle box to a M-
5A1.  Finally repeat the process to add an AU-1 Corsair. 
 
Save your work. 
 
Now we will add the Viet Minh forces.  Rather than repeat the entire 
process well take an existing oob and copy/paste the relevant unit to 
our oob.  Save your work.  (Again.)  Select Open from the file Menu 
or Toolbar.  Select VM-308.oob to take a company from the Viet 
Minh 308th Division.  We don’t need a whole division or even a 
regiment, but let’s bring over a whole battalion.  Select Infantry Bn 
79, then copy. Immediately Open up scratch.oob by selecting Open 
from the Toolbar/File menu.  If prompted to save changes, click no 
(since you don’t want to alter the master file).  Back in scratch.oob 
select the top line ‘Order Of Battle’ and Paste the Battalion using the 
Date menu or Toolbaar.   
 
Save your work. 
 
We’ll want to trim this oob down a bit, so select 1/79 and delete it as 
well as 2/79 using the Data Menu or Toolbar.  That will leave you 
with Major Ngoc, an HQ Squad, the 3/79 Battalion and the Battalion 
Mortar Company. 
 
 
 
 
 

The Submap Editor 
 
Save your work, the oob is done and we are ready to move to the Submap editor.  Open the editor and select 
the Dien Bien Phu master map.  You should get the Submap Message ‘Map file is a full dta map.  OK to 
create a new submap?’  If you find you open a map file that is not a master map, I strongly suggest that you 
close it without making any changes.  Altering an existing submap can affect other scenarios that use it, 
causing an error in reading. 
 

 
 
Let’s select an out of the way village for our fight.  First, to get 
a better feel for the map, zoom out using the ‘-‘ button or the 
‘2D Zoom Out’ Option from the Display menu.  Then scroll 
all the way down to the southwest corner of the master map.  

There is a village there that suits our needs.  It is bounded on three sides by a stream.    



 
 

 
 

Just below the northern stream that 
runs E-W, click on a hex to set the 
northwest corner of our new map.  
The rest of the map to the north and 
west will now be shadowed out.  If 
you want to move that corner, left 
click again.  For the south east corner 
let’s pick a point in the wooded 
village area near the bottom of the 
map.  Right click on a hex in that area, 
shading the rest of the map.  You 
should now have a area about 30x27 
hexes.  Select Save from the toolbar or 
File menu and save the map as 
scratch.map.   
 
 
 
 
 
 



 
While the master maps are labeled with actual names, in this case we are making a hypothetical scenario, so 

let’s add some labels.  From the Mode menu, select ‘Label 
Add/Delete’.  Now click on the main village and call up the Label 
Dialog.  In the Label box type ‘Ban Lai’ and choose Center as the 
option for Justification.  You can change the size and color of the 
label as well in this dialog. 
 
 
Save your work and exit. 
 

 
The Scenario Editor 
 
Now open the Scenario Editor and click ‘Cancel’ when prompted to open a file.  Select ‘New’ from the File 
menu or Toolbar.  When prompted, open the scratch.map file we just created, the scratch.oob as well, and 
finally the main.pdt file.  This will call up the Header Dialog, which will contain all the default values for 
this game.  In the Title box you can name the scenario anything you like – ‘Roll Your Own’, ‘My First 
Scenario’, ‘Brave New World’ etc.  You can also set the 
Date and Time that the scenario takes place.  It is a good 
idea to set this before doing other work, as it makes 
handling reinforcements and releases easier.  For this 
example, use May 1, 1950 at 1200 hours.   Set the Turns to 
12 and leave the rest alone.  Click OK to exit the dialog.  
This calls up the Description Dialog.  Enter your name and 
then a brief description of the scenario (large/small? 
PBEM? Historical background, objectives, outcome, etc. 
“Small\\PBEM\\Somewhere on the plains of northern 
Vietnam.  A force of French Troops is tasked with clearing 
a small village said to be held by a force of Viet Minh 
regulars.”  Note that the ‘\’ is the equivalent of a carriage 
return on a typewriter.  Click OK when you are done.  
(You can always go back and edit it later.  
 

 
 
 
 
 
 
 
 
Save your work and name it scratch.scn. 
 
 
 
 

 
We’ll start by placing objectives.  Click on the village hex just to the north of the road junction.  Either click 
on the ‘Add Objective’ button on the toolbar or select ‘Add Objective’ from the Hex menu to open the Set 
Objective Dialog.  Since this is in what will be a Viet Minh held town, set Nation to Viet Minh.  Leave the 



Type set to the default ‘Normal’ and leave the ‘Hidden’ box unchecked.  We will only place ‘Normal’ 
objectives, but please spend time with the manual to learn 
about the 6 (3 types x hidden/non-hidden) types of objectives 
that are available to you.  Finally, set the value to 25.  Both 
‘Nation’ and ‘Value’ must have values other than ‘none’ or 
‘0’.  There are no neutral objectives in Squad Battles.  Repeat 
the process to add 4 more 5 point objectives – 2 in the village 
hexes covering the SE approach to the village, 1 in the far rear 
village hex and  1 in outlaying village hex in the SW.    This 
means that the French (Side 1 in this scenario) have 45 points of objectives available to them.   
 

 
Note: the color of the objective marker will 
reflect the ‘owning’ side.  If one of your 
objectives is blue, it has been set to French 
ownership, and should be changed. 
 
 
We’ll set the Victory Levels now.  Re open 
the Header Dialog from the Scenario Menu.  
Well set a Major Victory to 45 points – 
meaning that the French will need to capture 
all objectives while not losing more men then 
casualties inflicted on the Viet Minh.  
Actually a pretty tall order considering they 
are attacking what will be a fairly well 
fortified position and a roughly equal force.  
For a Minor Victory well force them to take 
the village, but not the outlaying buildings 
and let them suffer a few more casualties.  
Set that level to 30.  Well set the other levels 
at 15 and 0 respectively.  This will likely be 
adjusted in playtesting. 

 

 
 
Save your work. 
 
Now time for the defense.  From the Hexes Menu, select ‘VietMinh Owner’ and then select ‘Add/Clear 
Bunkers’.  Click on the village at the intersection in order to cover the village. 



   While the hex is selected from the 
Hex Menu, select ‘Bunker/Pillbox/Cave Facing’.  The default is ‘none’ 
but we’ll make this face ‘Down’.  Units in the bunker won’t be able to 
fire at the three rear hexes.   Selecting ‘Trench’ from the Hex Menu add 
a few Trench markers to bolster the defense.  If you add too many, you 
can delete them by right clicking on the offending marker.  We’ll also 
add a booby trap and a mine field by clicking on Mines from the hex 
menu.  Click on the hex across the path from the bunker. Obstacles will 
be placed in the hex.  Click again and it changes to Barriers, again and it 
is a Booby Trap.  As you keep clicking you will cycle through the 
various things available to deploy.  If you want to back up, Right Click.  
Add a Tank mine on the flank of the village, next to the Booby Trap.   Add one more bunker to the rear 
village hex for a command post.  The rest of the village should get improved markers placed on them. 
 



 
 
Save your work. 
 
Now we’ll deploy the Viet-Minh.  If the Unit Dialog is not displayed, select ‘Display Unit Dialog’ from the 
Command Menu.  Click on Infantry Bn 79 to expand it.  Select Major Ngoc and then Right Click on the rear 
Bunker to place him there.  Since he is safer ‘On Ground’, 

Toggle ‘On Ground’ 
either with the 
Toolbar or from the 
Command menu.   
Right click again on 
the hex and the next 

unit from the oob, the HQ Squad and their radio will be 
deployed, also ‘On Ground’.   Let’s assume that the defense 
has been here a while and has had time to pre register some 
artillery strikes.   With the radio selected, from the 
Command menu, select ‘Toggle Setup’ to stamp the radio 
‘SETUP’.  Any artillery called in will not fall far off the 
mark.   
 

 



To give him artillery, select the Mortar Co in the Unit Dialog to 
expand it.  Now select the 82mm Mortar M37 (Not the Mortar 
Section!) and then from the Scenario Menu, choose Add 
Support which will call up the Support Dialog.   You can vary 
the Minimum and Maximum Delay, the number of tubes 
(change this to 4) and the number of Missions (set to 4 as well).  
Do not check Random Support or Available First Turn. 
 
Save your work. 
 
In the Unit Dialog, select 3/79 Inf to expand it.  Then select Cpt 
Trung.  Right Click on the bunker on the village to place him 
there (On Ground).  Right Clicking on another hex will deploy 
the next unit, in this case, Lt. Kim.  Deploy Lt. Kim, his platoon and Lt. Thanh and his platoon throughout 
the village.  If you want to reposition a unit after it is on the map, select a unit normally, then CTL-Left Click 
on the hex where you want to move it to.  Finally, deploy the AT and RR Crews to fill out the village. 
 

 
 
Save your work. 
 
3/3 Platoon will come on as reinforcements.  Deploy all of the 3/3 Platoon in a stack on the map edge where 
the trail leaves the board.  Select the entire stack and use the button on the toolbar or the Command Menu to 
Toggle off ‘On Ground’.  (We want them mobile when they come on.)  Before we make them 
reinforcements we should tell the AI where to send them when they come on.  We will not worry about the 



rest of the units, the AI will make some defensive moves, but there is not a lot for them to do.  From the 
Scripts Menu, select A/I Mode or click the button on the toolbar.  

 
 Now select the entire stack by double 
clicking.  Finally Right Click the central 
bunker.  You should see a red arrow pointing 
to the hex with a white ‘1’.  Right Click 
again and the number increases.  Set it to 6.  
If you want to go back, CTL-Right Click to 

step back.  This means that on Turn 6, those units will move toward the bunker and occupy it or prevent the 
other side from doing the same.  Click the AI button or select 
A/I mode from the Scripts menu to turn off A/I Mode.   
 
Once again, select the entire stack by double clicking.  From the 
Units Menu, select the Add Reinforcement to open the 
Reinforce Dialog.  The Default values will be turn 1 of the 
values set back in the header.  To make them come on in turn 6, 
set the minute to (6 x 5 =) 25 (remember turn 1 = 00!).  You can 
also vary the Scatter (more for paratroop landing) protection (to 
prevent the other side from sitting on your entry hex) and 
Probability (to increase FOW).   Click OK.  To increase FOW 
let’s give these reinforcements a variable entry hex.  (We could 
have done this originally, but you can modify reinforcements 
after the fact.)   Select Scheduled from the Units Menu, then 
click on reinforcement to reopen the Reinforce Dialog.  Click on 
the Add Alternate button and open the Add Alternate Dialog.  
Assign the location 0 16 (where the trail in the SW leaves the map) and set the Probability to 50.  There is a 
now an even chance that the reinforcements will arrive in the NW or SW.  We are now done with the Viet 
Minh. 

 



 
 
 
Save your work. 
 
For the French, let’s place Cpt Renard in the rear to control the battle.  Select Renard in the Unit Dialog and 
deploy him along the edge of the trees in the rear.  He’ll be ‘On Ground”, but that is fine.  Deploy the M-8 
Greyhound in the lead and the Stuart in reserve.  If you want to change the initial facing of the vehicles, 
select the vehicle and then use the Toolbar button or the Command Menu options to Turn 
Clockwise/Counterclockwise. Sprinkle Lt. Dan’s 1st Platoon between the two.   When you deploy Lt. Dan, 
toggle off On Ground immediately and the rest of 1st platoon will also be placed on the map on their feet.  If 
you need to reposition anyone, select them and CTL Right Click the location you would like to see them.   
 

 
 
 
 
The French will have a pair of Corsairs available as support.  Select the AU-1 Corsair in the Unit Dialog, 
then, from the Scenario menu choose Add Support to bring up the Support Dialog.  Set Minimum to 3, max 
to 6, number to 2 and missions to 2.  Click OK. 



                               
 
When you are satisfied, save your work. 
 
We’ll now add French reinforcements.  On the map edge, along the trail due East of the village, deploy the 
second Platoon by selecting the 2-1/2 Ton Truck in the Unit Dialog and Right Clicking on the hex.  The 
Truck will deploy with the units loaded on board.  If you wanted them on foot, you could have chosen to not 
select the truck, but just Lt. Roger, as you would normally.  If you want to unload them now, there are a 
couple of ways to do that.  First you could select the Truck on the map.  In the info box deselect the units on 
board and t hen Delete to remove the truck from the map.  You could select the units and CTL-Right Click to 
move them out of the hex.  For now let’s leave them loaded.   Toggle into A/I mode and right click the hex 
where the stream crosses the trail.  Right Click again until the number is ‘6’  Now unselect all the units in the 
stack, and in the hex info box highlight the three squads and Roger (but not the trucks!).  Right Click on the 
NE corner of the village and set that for Turn 7.  Right Click on the central bunker for Turn 8.  That should 
get the units off the truck and work them into the village.   
 



 
 
 
Now Select the entire stack and from the Units menu, select Add Reinforcement to open the Reinforce 
Dialog.  Set the Minute to 25 to bring them on in turn 6.  Click OK. 
 
Save your work. 
 
Since the French are on the attack, we’ll set a general script for the rest of their units as well.  Select the 
Greyhound and plan a probe and circuitous route around the defenses.  You set waypoints by Right Clicking 
as above.  Set the turns, etc etc.  Hold the Stuart back a few turns before scripting into the town.  Now we 
will set a script for an entire formation.  Up until now we have been assigning scripts to individual units, but 
it is often easier and just as effective to offer the A/I some general advice on objectives.  With one of the 1st 
Platoon’s units selected, choose from the View menu Highlight Organization or use the toolbar button.  
When you do this, all the individual orders should disappear.  Send the Platoon across the rice paddy to form 
up for an attack on the village behind the tall grass to the south of the village by right clicking on an 
appropriate hex.  Set a second waypoint at the central main bunker, again using right click.  Click enough 
times to advance the number to ‘7’.  This means that the Platoon will wait until turn 7 to attack directly into 
town.  
 



 
 
Save your work. 
 
At this point the scenario is ready for the work of playtesting.  Play it from both sides vs the AI.  Have the AI 
play itself.  (I like to see the AI play itself and end in a draw.)  Have someone PBEM.  Play it Hot Seat 
against yourself.  Each way you play it will open your eyes to options in the scenario (especially PBEM). 
Change the AI scripts up.  Use the Units menu or the tool bar to reduce the strength or effectiveness of 
individual units.  For example, if the unit in the southwest building proves too strong, you could delete the 
LMG by selecting that weapon only from the unit info area and then use the Delete button or Remove From 
Map in the Command menu.  To reduce the number of men, select the Squad and then deselect the remaining 
weapons (or they would get reduced as well) and select Decrease Strength from the toolbar or Command 
Menu.   Go back and tweak the victory levels.  Add or subtract turns.  My guess is that the French will need 
some help here. Good luck and have fun! 
 



 
 


